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1. About LCIT v5.1

LCIT (Linux Cluster Installation Tool) version 5.1 introduces several new features, as
well as refinements to existing features as requested by those who have worked closely
with the development team. Starting with the complete overhaul which began with LCIT
version 5.0, it is primarily intended as a service and support tool and provides many
methods for gathering cluster information and troubleshooting a cluster.



2. Installation

2.1. Live Version
LCIT is a Live CD, so using it is simple and no Operating System is required.

1. Place CD into the management node (1 GB RAM minimum requirement).

2. Boot management node from CD ROM.

3. Wait for LCIT to load, this may take some time as the file system is
compressed on the CD ROM.

4. LCIT will automatically login and boot into an X Windows session. From
there, the tool can be used normally (see sections 3 and 4).

2.2. Installable Version
NOTE: The installable version of LCIT is recommended for advanced users only.
1. Extract the latest archive (downloaded or from the Live CD in the | ci t
directory) for the LCIT installable version into an empty directory.

Ji,_:Jl X Desktop | /i_\

Prodigu:™ # od Jopt/lcit
Prodigy:soptslcit # ,/install
Starting LCIT install script...

##k | CIT requires the latest versions of the following packages *##

python, python-tk{a.k,a, tkinter), Tix{usually included with tk), expect, ssh cl
ient/zerver

ipmitool {optional). HPeli{optional), SMeliloptionall. java(optional)

#% LCIT client requirements *#*
=sh server, ipmitool(optional)

Press ENTER to continue, [l

2. Using a terminal, change directory to the location of the extracted archive
and type . / i nstal | asroot from the command prompt.

3. Assuming all necessary packages are properly installed, the install script
will finish and LCIT will be ready to run by typing | ci t from the
command prompt. All files are automatically installed to/ opt /I ci t .

= X Desktop ==
Python is linked,

Expect iz installed,

Expect is linked,

ssh is installed,

szh i linked.

ipmitool is installed,

ipmitaol is linked,

MPcli is installed.

HPcli is linked,

Shcli is linked,

Java is linked,

Creating links in /bin

Desktop Link Created,

Please wait while LCIT gathers data for this machine,..

collecting...

Could not open device at /dew/ipmi0 or Adew/ipmi/0; Mo such file or directory
Unable to get Chassis Power Status

% no jpmi drivers detected #t#

LCIT data gathering complete,

IT Installation is complete! Tupe 'lcit' to start.

Prodigut/opt/1cit # 1
z




2.3. Troubleshooting

1. If the CD fails to boot, you may need to check the system BIOS to make
sure that the CD ROM is set before the Hard Drive in the boot order.

2. If some ‘Failed’ messages appear during the CD boot process, this does
not necessarily mean LCIT will fail to load. Wait a few more minutes for
the system to fully load.

3. If the installable version fails to install or properly load after installation,
make sure the following packages are installed:

- python (version 2.4+ with python-tk, Tix)
- expect

- ssh client

- ipmitool (optional)

- java runtime (optional)

- MPcli (optional)

- SMcli (optional)

3. Running LCIT
Once LCIT has booted into X Windows, it is ready to be run. LCIT can be started one of
three ways:

1. Left click on the desktop and select “LCIT” from the menu

2. Click on the “Tools” button in the top panel and select “LCIT” from the resulting
menu.

3. Optionally, the tool can be run by typing the following in a terminal:
# lcit

3.1. Troubleshooting
If the LCIT program does not appear after clicking on a LCIT button, type

# killall -KILL python

This will terminate any existing instances of LCIT and then allow LCIT to be
started once more.



3.2. Resetting to Defaults
If needed, all the log files and IP tables can be reset to default (deleted) by issuing
the following command:

# cd /opt/lcit
# .lreset _defaults

4. Discovery

When LCIT is first loaded, the currently viewed cluster will only contain the management
node. There are two ways to begin discovering the cluster: Auto Discovery or the
Discovery Wizard. Both are found in the Options menu from the manager screen.

4.1. Auto Discovery
This method of discovery simply uses all defaults for IP range searches and
automatically places all newly discovered nodes into 'Unracked'. This can be
accessed by selecting Auto Discovery from the Options menu in the manager, and
requires no further interaction from the user. When using this method it is
recommended to only turn on one rack at a time and to make sure that after each
discovery all new nodes are placed into their appropriate racks through the
manager.

4.2. Discovery Wizard
This method of discovery is the recommended method for discovering new nodes
and can be accessed by selecting Discovery Wizard from the Options menu in the
manager. The wizard presents a few options for discovery: discovery of a new
rack, discovery of an existing rack, and importing rack data from external
sources.

=i| = Discovery Wizard | | A

Please select an action:

% Discover Mew Rack
~ Discover Existing Rack
~ Import “CAT Tabs

~r Finished

Back Cancel Mext




4.3. New Rack Discovery
By selecting this option, the wizard presents a few instructions for discovering
the new rack and entry fields for name, serial, and type of rack. The Search
Ranges button will allow the user to enter static IP addresses which do not appear
in the default IP search ranges. After following the on-screen directions, pressing
Next will begin the automated search and collection process.

1. Power on all nodes in the new rack
2. Mote the Rack Mame, Tupe, and Serial
2. Hait at least 5 minutes for nodes to boot image
4. Click Mext to begin the discovery process

Rack MName: |Rack 1

Fack Tuype: 1410-42L Rack w/ Outriggers —-|

14104RK
Rack Serial: |33R14L

Search Ranges... |

Cancel

- Add Single IF Currently Searched Ranges: Searching.
% fAcd IP Range  10.1.5.5 - 10.1.5.250
10.1.4.5 - 10.1.4.250 I 55.6%
|:] 10.1.8.5 - 10.1.3.250
10.1.2.5 - 10.1.2.250
to 127.0.0.1
1
S 4|_JJ| Progress | /l _\.|
collecting. . .
Insert | Done | 42.6%

After both progress bars have shown completed searching and collecting, the
wizard will display a summary of nodes that were collected and ask the user to
select what action to do next.

Rack 1 (MT:14104RX SMN:S3R14L)
MNew Modes Discovered: 13

Hew Hodes:

10.1.5.180, 00112575046A, IBM eServer BladeCenter LS20

10.1.5.164, 00145E1D3202, IEM eServer BladeCenter HS21

10.1.5.226, 0003EBOO4F4D, IEM eServer BladeCenter HSZ0

10.1.5.228, 0003EBOOS774, IEM eServer BladeCenter HSZ0

10.1.5.237, 0003EBOOS7AC, IBM eServer BladeCenter HS20

10.1.5.234, 0QOOSEBOOSFS4, IEM eServer BladeCenter HIZZ0

10.1.5.238, 0003EBESEZ3E, IBM eServer BladeCenter HSZ0

10.1.5.241, 00ODEOSBESEDE, IEM eServer BladeCenter HSZ0 4

Please select an option:
# Discover Another Rack

~r Discover More From This Rack
~ Finished

Back | Cancel | MNext

|
H




4.4. Existing Rack Discovery
This option allows newly discovered nodes to be placed into an existing rack,
and/or to re-collect node information from nodes currently in the selected rack.
The desired rack must be selected from the drop-down box in the center. The
Search Ranges button works similarly to the previous step for new rack discovery
and the checkbox titled Update Rack Data, if selected, will re-collect all node
information for the selected rack. Pressing Next will begin the automated search
and collection process, then the wizard will display a summary of nodes that
were collected and ask the user to select an action.

= __:Jl Discovery Wizard | AN

1. Make sure all rnewn and existing nodes
in the selected rack are powered on

2. Hait at least 5 minutes after power on
for new nodes to boot image

3. Click Mext to begin the discovery process

Select a rack:
LCIT (MT:0 SM:) -4|

Search Ranges. .. |

| Update Rack Data

Back | Cancel | Mext

4.5. xCAT Tab Import (currently limited functionality)
NOTE: Starting with LCIT v5.1, some xCAT functions may be utilized by LCIT.
However, this portion is still mostly in development and only contains a very
limited function set.

In order to import xCAT tabs for use with LCIT, you must place the following
pre-configured XxCAT files into the / opt /| ci t/ xcat - ext directory
manually:

host s
ipm.tab
nodenodel . tab (optional)

Once these files are in place, all address, racking, and alias names will be placed
into the manager with empty node information. Once the nodes are turned on,
the manager will be able to collect their actual information (see the Manager
section of this document for more on this).



4.6. Troubleshooting
If some new nodes do not appear after a successful discovery, please be sure to
check all physical connections, make sure each node is properly set to boot off
the network on the correct interface, and that each node is turned on.
Furthermore, make sure that each node has loaded their client images and have
been assigned an IP address.



5. Management
The Manager Interface is loaded when LCIT starts up and is where you'll be able to
interact with nodes after they are discovered.

File Options Wiew About

Cluster |--

Last Update: 12:30:37 04/13/2006

Active Modes: 18
[#] 00:02:55:06: 4E: 07 Inactive Modes: O

[# 00:09:EB:8C:01:5C Total Nodes: 18
00:0E:0C:35:7EEA
® (00DEOSSCRCS Rack Distribution

Sub (MT 1410 SM:1410-420) Main (MT:14104RH SNiEHMGCATHY @ 4
= Sub (MT:14104RK SN:1410-4200: 14
[m] o6 05:50:71 187 : 94

2)00:11:25: 75:04:66
9 00112575ACDF
4)00:00:60: 5B:93: 05
a 000DEOSEFA9S R
5)00:09:6B: 00: 97:50 Tl Wil
6)00:09:68: B5:82: 35 ATeA 100, FESET: &
7coscaii o4 187 S latonter togy o
8) 00:039:EB:00: 4F 1 41 eserver XSEI"‘}EB 3a0: 1
5) 00 09: 6B: 00: AB: 29 e
[ 10} 00: 09:6B: 00: §7:F4 eserver xSeries 346:
113 00:09:6B: 00: A9: 51
123 00:09:EB:00: 96:E2
13) 00:09:EB:00: 97: 74
143 00:09:6B: 00: 97: AC
el 00r: A0 BB 16:54:30

R 7 =

‘ View by: Group by:

&l

K& RIRIE

MAC —l| RACK. —l|

I Cluster Integrity - 100% fg/éf/fg

The left-hand side of the window contains a tree with all discovered nodes in their
assigned rack groups. Under the tree are some viewing options, a cluster integrity
indicator, and a clock. To the right of the tree is a long vertical button which allows the
user to expand the tree to display more information about each node.

The right-hand side of the window is where cluster, node, and logging information may
be found. When the LCIT manager is first loaded, a cluster summary screen displaying
cluster node distribution is shown. Directly below the information page is a status bar,
which shows important message pertaining to actions that have been performed by the
user, as well as a message box which contains critical information regarding the status of
an individual node.



5.1. Node Tree
The node tree contains all nodes which have been discovered, listed by their MAC
(or IP) and grouped by their rack (or machine type). BladeCenters will contain
the nodes underneath them and at which slot they are located. There is also an
icon containing node responsiveness, node type, or whether there is an update
available for that node.

¥]  Active Node Inactive Node

[ Active BladeCenter Inactive BladeCenter

E Active Storage Inactive Storage

i Update Available : BMC or Alternate Address

The tree can also be viewed by IP Address instead of MAC, as well as Machine
Name(Type) instead of Rack. These can be selected via the “View by:” and
“Group by:” menus, respectively.

Wiew by: Group by: I
MAC —ll RACK —ll Hl ALL | Active | Down | |

Additionally, the tree can show only Active or Inactive (Down) nodes by selecting
the appropriate tab above the node tree.

5.2. Node Tree Options Menu

By right clicking on any node in the tree, an options menu will appear with some
node, group, and general options.

Options
Sort
Nocle
Group

Identify
Eject CO

Export
Update

Restart
Shutdoun P

The “Sort” sub-menu allows for the tree to be resorted ascending or descending
based on the node’s identifying value currently on the tree.

The “Node” sub-menu allows for the node which was right clicked on to be
identified or for its information log to be exported. The currently selected node
will appear above these options.



The “Group” sub-menu lets the user Export information logs, send Identify, Eject
CD ROM, Update, Restart, or Shutdown commands for an entire group (or type,
depending on which view is selected). The currently selected group will appear
above these options.

5.3. Detailed Tree View
To see a more detailed version of the Node Tree, either click the vertical bar to the
right of the tree with the plus[+] symbol, or select Toggle Details from the View

menu.
4| __;Jl LCIT Cluster Manager | /l &
File Options ﬂl fitaoLrt
BLL | EEiive | Toggle Details
Log Differencg
HAC Address |IF' fAddress |Ser‘ial |Machine |Tl=|pe Groug S
: 10.1.5.192  10CARYH BEFOLLK  eserver xSeries 345
[ 00:02:55:06:4E: 17 10.1.5.184  7BX48E3 BE7ALLK  eserver xSeries 330
[ 00:09:6E:8C:01:50 10.1.5.172  23A07E5 BEEELZ  eserver xSeries 335
[ 00:0E:0C:35: 7E:BA 127.0.0.1 KPAHO4S 8840320 eserver xSeries 346
= OOODEOSSCFCE 10.1.1.592
Sub (MT:14 410-42L) (N I N
00:05:50:71:87:94 10.1.1.40 23A0104 BE7FLHN BlaceCenter
2)00:11:29:75:04:6A 10.1.5.180 23A0540 8850122 IEM eServer BladeCenter LS20
B 00112575ACTF 10.1.1.56
4)00:00:60:5B:93: 16 10.1.5.241 23A0024 8843212 IEM eServer BladeCernter HSZ0
@ QOODEOSEF485 10.1.1.58 =
5)00:03:EB:00:37:50 10.1.5.248 KPX1168 867841K IEM eServer BladeCenter HS20
E)00:03:EB:B5:32:36 10.1.5.238 KPHF372 883221K IEM eServer BladeCenter H520
7100:03:EB:00:9F :54 10.1.5.2489 KPXa833 8E7851H IEM eServer BEladeCenter HS20
8)00:03:EB:00: 4F : 4D 10.1.5.242 78L1325 867841 K IEM eServer BladeCenter H320
9)00:03:EB:00:A3:23 10.1.5.248 KPX3836 8E7851H IEM eServer BEladeCenter HS20
[l 103 00:08:BE: 00:97:F4 10.1.5.243 KPX1162 SE7E4LH IEM eServer BladeCerter HS20
[l 113 00:08:EE:00:A9:51 10.1.5.247 KPX3807 8E7ESLH IEM eServer BladeCerter HS20
[l 123 00:08:BE: 001 96:E2 10.1.5.245 KPX1175 SE7E4LH IEM eServer BladeCerter HS20
[l 133 00:08:BE: 00:97: 74 10.1.5.244 KPX1157 SE7E4LK IEM eServer BladeCernter HSZ0 -
[l 143 00:08:BE: 00: 97 :AC 10.1.5.250 KPX1172 SE7E4LK IEM eServer BladeCernter HSZ0
[l 00:AD:BE:16:54: 50 10.1.1.60 1T41428171 STORAGE 1724-100  FASET £
View by: Group by:
MAC — | RACK — |
Cluster Integrity - 100% fg’:’égfgi

This view shows MAC Address, IP Address, Serial Number, Machine Type, and
Machine Name(Type Group) as columns in the expanded tree. Items can be
interacted with exactly the same as in the collapsed tree. Double clicking on an
item will collapse the tree and open the node’s information page.

To collapse the tree, either click the vertical bar to the right of the window with
the minus[-] symbol, or by selecting Toggle Details again from the View menu.




5.4. Looking at Node Information

Double clicking on a node listed in the node tree will bring up the Node

Information tab.

4| _J'Jl LCIT Cluster Manager

==

File Options View About

ALl || Active || Doun | Cluster | noce || Log
o (TG ST MAC Acdress: DODEOCTS7ESA OOOEOCASTEGE 000DE0SS4A3C OOODGOSSAAGD, (BMC: O0ODGOSSCFCE) | )
- e — TP Address: 127.0.0.1 10.1.1.15 10.1.3.1 10.1.4.1 10.1.5.1, (BMG: 10.1.1.82
[ 00102155 706 201 Hostrane: Frodizy
[l 00:02:55: 06:4E: 07
00:09:68:8C:01 :5C Manufacturer: TBM
Procuct Name: eserver wSeries 345
Machine Type: 8340320
DOCDE0ISEFCS Serial Munber: KPAXO49
ET0S Yersion: KPELZ4AL5-1.10
(M0 05: 30 O BMC ¥ersion: 1.c
2100:11:25:75: 04160 ’—
s 00112575ACF Bocate
00005058 95: 6] CFU Socket 0: GeruineIntel Heon S500 MHz
@ O00DECSBFAS5 CFU Socket 1: Avallable
5)00:09:8B:00:97:50
BT Total Memory: 2@S12 ME
SOERT AR Memory Slots Used: 2 of 8
7100:09:8B:00: 9F 154
) 00:09:5B:00: 4F 14T PCI Slots Used: 1 of 4
A 5 00:09:E8: 00 AR 29 .
) Uptime: 33d 22h 27 S0s -
[ 100 000915 00: 57 :F4
[ 117 00: 0915 00: AT 51 ——
[ 12) 00:09:6B:00: 96:E2 _
| — bRl
[+ 13 00:09:5B:00: 97: 74 =
[ 14} 00:09:EB:00: 97:AC slot Usage: | —
Il 00:A0:BS: 16:54: 50 '] e PR
| = _
Wiew hby: Groug by: |ping: responding at 0.031 ns
M _-| RACK 5
W donm | 041308 I
Cluster Integrity - 100% 1o 41 < 0E 7

Information about the selected node is displayed in the right side of the window.

For most node types, several functions can be performed from this page:

BIOS Wersion: KPEL34AUS-1.10
BMC Yersion: 1.c

Update |

Actions: Toentify | Eject CD |
Export | Open S5H |
| Reboot | | Shutclown |
BMC Actions: | Export Info | ‘ Export Events | | Clear Events |
Update: This will update the firmware of this node to the version on the CD

(only if the CD contains a newer version)
Identify: This will turn on the identify light for this particular node and will
also cause it to blink at a user specifiable rate
Eject CD: Ejects the CD ROM drive tray
Export: Exports the current node’s information to a log
Open SSH:  Opens a terminal automatically logged in to the node

Reboot: Reboots the node




Shutdown:  Turn the node off safely

Furthermore, if the node contains a BMC, additional actions will be available:

Export Info:  Exports the information currently contained by the manager about
this BMC

Export Events:Connects to the BMC and exports the entire Sensor Event Log

Clear Events: Connects to the BMC and clears the entire Sensor Event Log

5.5. Looking at BladeCenter Information
If a BladeCenter is double clicked, the Node Information page will show a report
containing which nodes are in which slot, their current response status, as well as
which fan, power supply, switch, and management slots are in use.

Blade Slot Usage:

O active [l pown ] Enpty [l Unknown

Front:

4 3 B 7 8 9§ 101112 13 14

1 2 3
2)00:11:25:75:04 16A
9 00112575ACDF

4)00:0D:60:5B:93: 06
a QO0DEOSEF435 e
5) 00: 09 :E6B: 00:97:50
6)00:09:5B:B5:82:36
7)00:09:EB:00: 9F : 54
[/

&l

&l

B)00:08:6E:00: 4F 14D
A 00:09:68:00:A:29
[+] 100 00:09:6E:00:87 :F4
[+l 11)00:08:6B: 00:A9:51
[¥] 120 00:09:6B:00:965:E2

120 00:09:6B: 00:97: 74 fictions: Export

[v] 14) 00:05:EB: 00: 97 :AC

The only action available for BladeCenters is the ability to export their node
information log.



5.6. Looking at Storage Node Information
When a Storage node is double clicked, the Node Information page shows
information regarding the size and status of each hard drive slot. Actions include
being able to identify one drive at a time or exporting the storage node’s
information log.

MAC Address: COO0AOBE1ES43C, (00AOBI1ESSED)
IP Address: 10.1.1.60, (10.1.1.61)
Machine Tupe: 1724-100 FASET
Serial Mumber: 1741428171, (1T41428032)

Firmware Wersion: 06.12.16.00
NVSRAM Version: N1724F100RI1Z2V0S

Total Drives:
Certified Drives:
Uncertified Drives:
Spare Drives:

o e m

Digk Slot Usage:
[ optimal B soare B Failed

Tray O
4 5 B ii ‘i

Actions: Tdentify ‘ ‘ Export




5.7. Node Message Box

Located at the very bottom of the right side of the manager window is the

message box which contains time-stamped information about a node when it goes
offline, comes back online, or has an updated information file after coming back

online. Scrolling over each entry will highlight the appropriate node on the tree,

clicking the entry will bring up that node’s information page. These messages

will also appear on their respective node’s information page at the very bottom.

|i File Options View About

ALl | Active | Doy |

Cluster | Nocle: | Log |

s O0:09:EB:5C: 01150
[ 00:0E:00:35: 7E:BA
a Q0ODE0SSEFCE
[# 00:11:25: 4 :02: 40
a 00 EDO

9 00112575ACDF

41 00:00:60:5B:93: 06
8 O0ODE0SBF4SS

5)00:08:6B:00:87:50
B)00:03:6B:B5:82: 36
7)00:08:6B:00:9F:54
2)00:03:6B:00:4F 140
)00:08:6B:00:A8:29
EH 100 00:03:6B:00:97:F4
11300:08:6B:00:A8:51
EH 12)00:03:6B:00:95:E2
13100:08:EB:00:57:74

EEERE =H

00:A0:BS:16:54:30
a OQ0ADBELESSED

Total Memory:
Memory Slots Used:

PCI Slots Used:

Uptime:

Slot Usage:

4x1024 MB
4 of 4

0 of O

Od oh Om 53s

PCI

E—

[—
=
—

H-

RAM

fictions:

Toentify ‘

Eject CO |

Expart

Open 55H |

Reboot. Shutdoun

BMC Actions: | Export Info | ‘ Expart Events | | Clear Events

Messages:

(04/13/08-17:24:01) ! IHarning! ! Sub -»> 00112575046A failed to respaond!

(IEM eServer BladeCend| |

Wiew by:
MAC —l|

Group by:
RACK  —

I Cluster Integrity - 36.6%

0
17:26:11

‘ping : not responding

(04/13/06-17:26:03) +++0nlinet++ Sub -»> O0ODSBBBSS236 is now active. (IBM eServer BladeCenter H3

| (04/13/06-17:24:01) ! lkarning! ! Sub -> 0009EB00ASS] failed to respond!
04/13/08

(04/13/06-17:24:01) 1! ldarning! ! Sub -» 000SEEO04F4D failed to respond!

5.8. Help Screen

(IEM eServer BladeCent

(IEM eServer BladeCent

i

To bring up a brief help screen from inside the manager, select Help from the

About menu.




6. Logging Cluster Information

There are several different types of logs, and different ways to go about accessing each of
them. All logs exported within the program will appear in the “Log” tab over the
Information page and will automatically be opened upon export. These logs are sorted by
date, then by node (or other log type), and then by time of export.

Cluster | Node [ LDgL
B 1cit.ibm.comn In this view you can see recorded logs X
bhased on their creation date and tupe.
04_13_ 2006
El summary
i
Fiefresh ||.\| | -

Double clicking on any log file, represented by a file icon, will open the log file in the log
window to the right of the log tree.



6.1. Summary Log
Summary logs are appended to at every refresh interval (5 minutes by default).
Each entry in the log contains a timestamp, followed by a short report on the
current status of the cluster, as well as the status of any nodes which have recently
gone offline, or come back online.

wiHhBegin Cluster Summary Log Entrufiiis
Log Time:04/13/2006 17:24:01

Last Update:17:24:01 04/13/2008

Active Modes:B

Inactive MNodes:12

Total MNodes:18

---Changed Mode States——-

HHEAEND Cluster Summary Logiiid

RHABerin Cluster Summary Log Entrugsss
Log Time:04/13/2008 17:259:02
Last Update:17:25:02 04/13/2008

[Sub (MT:14104RH SM:1410-420)]1 0009EB0O4F4D,10.1.5,242, 7801325, IBM «
[Sub (MT:14104RH SM:1410-420)]1 0009EBOOSEEZ,10.1.5.245,KPH1175,IEM ¢
[Sub (MT:14104RX SM:1410-421)] 0003EBO0STI0N,10,1.5,248 KPH1168,IBM «
[Sub (MT:14104RK SM:1410-421)] 0009EBO0STT4,10.1.5.244 ,KPH1157 ,IBM ¢
[Sub (MT:14104RH SM:1410-421)] 0009EBOCSTAC,10.1.5.250,KPH1172,IBM «
[Sub (MT:14104RH SM:1410-420)]1 000SEBOCSTF4,10.1.5.243,KPH1162,IBM ¢
[Sub (MT:14104RH SM:1410-420)]1 0009EBOOSFS4,10.1.5.249,KPH3833, IBM «
[Sub (MT:14104RH SM:1410-420)]1 0009EBOORB29,10.1.5, 246, KPHI836, IEM ¢
[Sub (MT:14104RX SM:1410-421)] 0003BBO0OASSL,10.1.5,247 KPH3307,IBM «
[Sub (MT:14104RH SM:1410-421)] 000SEBBSE236,10.1.5.238,KPHFS72,IBM ¢
[Sub (MT:14104RH SM:1410-4213] 000DECSBISDE,10.1.5.241,23A0024 ,IBM ¢
[Sub (MT:14104RH SM:1410-420)]1 00112575046A,10.1.5.180,23A0540,TBM «

Active Modes:B

Inactive MNodes:12

Totsl MNodes:18

HEAREND Cluster Summary Logiids

HatiBesin Cluster Summary Log Entrugiis

Log Time:04/13/2006 17:26:03

Last Update:17:26:03 04/13/2006

Active Modes:7

Inactive Modes:11

Total Nodes:l18

---Changed Mode States---

[Sub (MT:AH04RE SM:110-420)] O0038BBS8236,10.1.5. 238, KPHFA72, IEM
HHEAENGD Cluster Summary Logiied




6.2. Message Box Log

If any messages appear in the Messsage Box, these messages may be exported to a
log by selecting the File menu, then Export, Messages.

Ji ,_:Jl LCIT Cluster Manager | /l AN

File Options View Ahout

ALl | Active | Town | Cluster | Mode I Log

B lcit.ibm.com (04/15/06-17:28:04) +++0nlinet++ SUb -5 O00SEBOO4FAD is nom active. [%)
(04/13/06-1 +++0nlinet++ Sub -> O000ZEBO0SVAC is now active.
(04/13/06-1 ++t0nlinet++ Sub -» ODOSEBOOASSL is now active.
(04/13/08-1 +++0nline+++ Sub -> O00ZEBOOSFS4 is now active.
| (04/13406-1 ++t0nlinet++ Sub -»> OD0SBBO0S7S0 is now active.
[ 00:0E:0C:35: 7E:6A M| (04/13/08-1 +++0nline+++ Sub -> OODSBBO0S7?4 is now active.
& QOODBCSSCFCE (04/13/06-1 ++0nlinet++ Sub -> O0DBBOOSEEZ is now active.
(04/13/08-1 +++0nline+++ Sub -3 OOODEOSESADE is now active.

R e (04/13/06-1 +++Onlinet++ Sub -> OODDBECDABES is nom active.
s (0112541AB00 (04/13/08-1 +++0nlinet++ Sub -» OO0IEBOOSTF4 is now active.
(04/13/06-1 ++t0nlinet++ Sub -»> 00112575046A is now active.
(04/13/068-1 +++0nline+++ Sub -3 ODOSEBESE236 is now active.

105:50:71:87:84 (04/13¢06-1 I Hikarning! ! Sub -» Q009BBOOASSL failed to res

PP ey (04/13/06-1 Hdarning! ! Sub -» OOOSEBOOSTAC failed to rest

I SRR (04/13/08-1 tharning! | Sub -> DOOSEBO04FAD failed to res

9 00112575ACOF (04/13/06-1 lhlarning! 1! Sub -» O00SEB00S774 failed to resy

C 0T B0 -ER- 3. (04/13/08-1 Harning! ! Sub -» ODOSEBOOS7F4 falled to regp
40O EE TR R (04/13/06-1 Harning! 'l Sub -» OO0SEBOOSEEZ failed to res;
9 O0O0DEOSBF435 (04/13/08-1 tharning! ! Sub -» 000SEBO0S7SO falled to resy
5)00:09:5E:00:87:50 (04/13/06-1 !War'n{ng! ! Sub -»> 00ODBOSBI3DGE fa}led to resp

! (04/13/06-1 tWarning! ! Sub -» OOOSEBOOABZS failed to resi

£)00 (04/13/06-1
04713/ 08-1

(04/13/06-172

Hlarning!
1 arning!
Harning! !

! Sub -»> ODOSBBOOSFS4 failed to resp
! Sub -» OOOSEEBSE2EE failed to rest
Sub - 00112575046A failed to resp

Save As... Ielete Log
3 11E:54:3C
@ 00ACBB1ESBEQ
T Fefresh |=] T o
rad
View by: Group by: \Message dump log generated.
MAG RACK _.l (04/13/08-17:28:04) ++4+0nline+++ Sub -> O00IBBOO4FAD is now active. (IBM eServer BladeCenter HS20) K
| (04/13/06-17:27:04) +++0nline+++ Sub -> O009BBOOS7AC is now active. (IBM eServer BladeCenter HS20) =
Cluster Inteqrity - 100% 04/13/06  (04713/06-17:27:04) +++0nline+++ Sub -> 00096B0OASSL is now active. (IBM eServer BladeCenter HSZ20) It
anty - 17:85:42 (04/13/06-17:27:04) +++0nline+t++ Sub -> O00IEBOOSFS4 is now active. (IEM eServer BladeCenter HS20) £




6.3. Global Log
The global log contains all information accessible to the manager about the
cluster, including the distribution of nodes among each rack group, and a listing of
each node’s information log. To export a global log, select Global from the File,
Export menu.

Cluster | Mode [ LDg]

B 1cit.ibm.con MHCluster Statistics#d

Cluster Fack Mame:Main

EHe7 04_13 2008 Cluster Machine Tupe:l4104R¥

Cluster Serial Number:EHNGCATH

OOOZSS7R0E2A,10.1 5,192 Active

O0O35BEC01SC,10.1.5.172Active

= ﬁiﬁessages O0OEQCESTERA, 127.0.0. 1 Active
E117:35: 21 001 12541024C,10.1 .5, 2233 Active

LA

El sunnary Cluster Rack Mame:Sub

Cluster Machine Type:1l4104RH
Cluster Serial Number:1410-42L
000S50718794,10.1.1. 40:Active
OOOSEBOO4FAD, 10, 242 Active
OOOSEBOOEEER 10, 245 Active
OO03EBO0ATS0,10.1.5. 248 Active
O0O03EBO0aTT4,10.1.5. 244 Active
OO03EBOOITAC,10.1.5. 250 Active
QOOSEBOOSTF4 , 10, L243:Active
QOOSEBOOEFS4 , 10, .243:Active
O0OZ5BE00AS2T,10.1 .5, 245 Active
O0OZ5BE00ASS] ,10.1.5. 247 :Active
0009EBESE236,10.1.5. 238 Active
QOODEOSE33DE, 10. 241 rActive
001 12575046R,10. L180:Active
O0AOBB1ES43C,10.1.1.60:Active

e il
o ononoon Ol on On Ol oo e

#HComplete Mode Infof#

BITART OO02SSTBOEZAN

Mode IP:10.1.5.182

Mode MAC: QOOZSS7BOE2A O002S57ROEZE
Mode Hosthame:lcit-client

Mode Manufacturer:IBM
Mode Product Mame:eserver =Series 345
MArds Markine Tine s fR701 1Y /

Fefresh H |/

Global dump log generated.




6.4. Details Log
To export a details log, select Details from the File, Export menu. This log show
a condensed detailed information log which contains all nodes sorted by rack
group, listed with their MAC addresses, IP addresses, Serial numbers, Machine
Type, Firmware versions (also BMC MAC and IP if they exist).

Cluster | Node [ Log]

B 1oit.ibm.con chine Tupe, (BMC MAG-IFY # X
B> 04_13 2008 OZ557ROGEE, 10.1.5.192, 10CARYH, GEEL49AUS-1 .12, 867011K, (-3
= 09EEACO1SD,10.1.5.172, 23A0725, TEEL32AUS-1 .11, BE7EE1Z, (-)
OEOCISTERE 000DEOSS4A3C O00DE0SS4ASD,127.0.0.1 10.1.1.15 10
1125410240,10.1.5.239 10.1.5.173,106E7ER, APELL9ALS-1. 04, 731
= global 1.1.40,22A0104 , unknown, BE771LHH, (=)
Bl 17:40:29 SEBO04F4E,10.1.5.242, 76L1325, BREL34AUS-1 .09, 857841 K, (-)
e SEBO0SEES,10.1.5. 245, KPH1175, BREL34AUS-1 .09, 857841 H, (-)
= %messages 9EB009751,10.1.5. 248, KPH1168, BREL34AUS-1.09, 857841 H, (-)
B 17:35:21 9EE009775,10.1.5. 244, KPH1157 , BREL34AUS-1.09, 857841 H, (-)
SEE00I7AD,10.1.5. 250, KPH1172, BREL34AUS-1 .09, 857841 H, (-)
Bl sunmary 9EBO0ITFS,10.1.5. 243, KPH1162, BREL34AUS-1.09, 857841 K, (-)
9EB00TFSS,10.1.5. 249, KPH3833, BREL34AUS-1.09, 857851H, (-)
SEBO0ASZA,10.1.5. 246, KPX3836 , BREL34AUS-1 .09, 857851, (-}
SEBO0ASSZ,10.1.5. 247, KPX3807 , BREL34AUS-1 .09, 867851, (-}
SEEESS257,10.1.5. 238, KPHFS72 , BSEL 20AU5-1 .07, 883221, (-)
DEOSESS0T,10.1.5. 241, 23A0024 , BHEL17AUS-1 .05, 8543217, (000050
125750458,10.1.5.180, 2380540, BKEL180U5-1 .05, 88501 22, (001125
OBB1658E0,10.1.1.60 10.1.1.61,1T41426171 1T41428032,06.12.1

el

Fefresh H I L=

Cluster node details log generated.




6.5. Node and BMC Logs

All nodes, regardless of type, can export an information log. This log may contain

more information not shown in the node information page. This can be done in
two ways, either by right clicking on the node in the node tree, then selecting
Node and then Export, or by double clicking on the node, and then clicking the
Export button at the bottom of the page under the “Actions:” heading.

Cluster | MNode [ LDg]

B lcit.ibm.com
04_13_2005

= O00SSOTLE7S4

El 17:50:57

[z QO0EOC3STERA

] details
El 17:44:50

Bz global

B 17:40:39

[-J—%messages
Bl 17:35:21

—E] summary

HHHHE
"L oz
L as

Node
Mode
Node
Node

Node
Mode
MNode
MNode
BIOS

CPU S
CPU S
Inter
Inter

DIMMO
DIMML

Mz im

Uptim
Load

Ot
Onboa

Fiefresh

Mk

DIMMZ2:
DIMM3:
DIMM4:
DIMMS:
DIMME:
DIMM7:

egin Node Log for QO0EQC3S7EGALMRHEN
Time:04/13/2006 17:55: 47HE
t Updete:17:95:05 04713/ 200604

Status:active

IP:127.0.0,1 10,1.1.15 10.1.3.1 10.1.4,1 10.1.5.1

MAC: QOOEOC3SYEEA OQOEQCISTEER 000DEOSS4A3C 00ODEOSS4A3
Hostrame : Prodizy

Manufacturer:TBM

Product Mame:eserver xSeries 346
Machine Type:8840320

Serial MNumber:KPAK049
Version:kKPEL34AUZ-1.10

ocket 0:Genuinelntel ,#eon, 3500 MHzZ
ocket 1Mot Specified,Unknown, 3800 HHz
nal L1 Cache:16 KB

hal L2 Cache:1024 KB

1512 MB

1312 MB

Mo Module Installed
Mo Module Installed
Mo Module Installed
Mo Module Installed
Mo Module Installed
Mo Module Installed
um Memory:le GB

e:2355137.39s
Average:0.4% 0.10 0.03 1/84 16737

o Device 1:ATI Radeon 7000-M,Yideo,Enabled

rd Device 2:Adaptec 7902W SCSI Controller,SCSI Control
rAl Tiewicre 3 Brosdenm §S721 Contenl 1er Fthernet Foshl e

=

I -

MNode dump log generated -» OQOOEQC3ISTEEA

If a node contains a BMC, this can only be exported by first double clicking on

the node which owns it, and then scrolling to the bottom of the information page
under the “BMC Actions:” heading and clicking Export Info. Another BMC log
available is a Sensor Event Log, which is accessed by clicking Export Events. To

clear a Sensor Event Log, click on the Clear Events button.




Cluster | Mode | Log |

B 1lcit.ibm.com
EH~7 0413 2008

= Q00550718734
El 17:50:57

= QOOEDCISVEEA
El 17:55:47

[Clgr (0112541RED0
El events (17:58:11)

= details
El 17:44:50
= glaobal
El17:40:39
= %messages
Bl 17:35:21
El summary

FRefresh

1| 04/13/2006 | 20:45:20 | Pawer Unit #0x01 | Power off _S
2 | 04/13/2006 | 20:45:23 | Power Unit #0x01 | Power off
3| 0441472006 | 01:22:43 | Power Unit #0x01 | Power off
4 | 04/14/2006 | 01:22:51 | Power Unit #0x01 | Power off
Save AsS... Delete Log
; |
I [

Full BMC Sensor Event Log exported successfully.

To save a log to another location or delete a log, scroll down to the bottom of the
desired log after opening it and click on the Save As... or Delete Log button,

respectively.

6.6. Difference Log Viewer and Diff Logs
To view the difference between two logs, whether they are different nodes, or the
same node exporting at two different times, you must first open the log difference
selector. This is done by selecting Log Difference from the View menu. This will
bring up a new pane above the log display itself.

Cluster | Node_[ Log ]

B 1lcit.ibm.com
EH=r 0413 2006
= 000550718734
El 17:50:57
(@ 000EOC3STERA
El 17:55:47

Select OLD | Select NEH | Show Diff

Hide |

'1. Select OLD log entry and press Select OLD button
2, Select NEW log entry and press Select MEW button
3. Press Show Diff button

o|To close or cancel the Diff bar at any time, press Hide

X

After opening, the user will be able to select which two nodes to compare. First,
select which file is to be the “Old” file, by first selecting it from the tree, then

clicking on the Select OLD button. The “Old” log will now appear with a Cross
next to it. Next, select which file is to be the “New” file, by selecting it from the



tree and clicking on the Select NEW button. The “New” log will show a Check
next to it. Click the Show Diff button to open the Difference viewer.

= __;Jl Difference Viewer |"/ iy
X [oLn) A04_13 2006/ dunmp_ OO0EOC3S7EEA_175547 _1og
- v/ [NEW] = /04 13 200E/dump_ODDEOCISTEEA 180448, 108
Node Machine Tupe:8284032U
Mode Serial Mumber:KPAHOS
BIOS Version:kKPE134AUS-1.10

L

CPU Socket 0:Genuinelntel,Heon, 3600 MHZ

CPU Socket 1:Mot Specified,Unknown, 3800 MHz
Internal L1 Cache:16 KB

Internal L2 Cache:1024 KB

DIMMO:S12 ME

DIMM1:512 ME

DIMMZ:512 MB ? R

DIMMZ:MNo Module Installed .

IIMME:ND Module Installed DIMMZ:Mo Module Installed
DIMMS:No Module Installed
DIMME:MNo Module Installed
DIMM7:MNo Module Installed
Maximum Memory:16 GB

Uptime: 2855137 .335
Load Average:0.45 0.10 0.03 1/84 16757

Onboard Device 1:ATI Radeon 7000-M,Video,Enabled

Onboard Device 2:Adaptec 7902W SCSI Controller,SCSI Controller,Enabled
Onboard Device 3:Broadcom 5721 Controller,Ethernet,Enabled

Onboard Device 4:Broadcom 5721 Controller,Ethernet,Enabled

Ontoard Device 5:IBM Automatic Serwer Restart - Baseboard HManagement Contec

PCI Slot 0:B4-bit PCI-H,Available
PCI Slot 1:64-bit PCI-H,Available
PCI Slot 2:B4-bit PCI-X,In Use
FCI Slot 3:84-bit PCI-H,In Use

0O00:00:00,0 Host bridge: Intel Corporation E7S20 Memory Controller Hubo (re
0000:00:00.1 Class ff00: Intel Corporation EVSESAETSZ0 Ercor Reporting Regi
QoO0:00:02.0 PCI bridge: Intel Corporation EVSZS/EFSZ0CETI20 PCI Express Po /
i~ I P

Export | Close |

In the Difference Viewer window, the text shown will be that of the “New” file.
Anything highlighted will display what was in the “Old” file when the mouse is
positioned over the line. The difference can also be exported to a human readable
text file by clicking on the Export button and can be closed by clicking the Close
button.

7. LCIT Options

A few handy options are available from the Options menu, such as user configurable
intervals and automated discovery.

7.1. Configurable Preferences
By clicking on Preferences under the Options menu, the user will be able to
change the refresh interval time (how often all nodes are pinged), change the
maximum number of messages shown in the message box, and change the Identify
Cycle parameters (how long the light stays on and how many times it blinks).



Ethernet

MAC Address IP Address Metnask Broadcast
ethd O0:0E:OC:35:7E:ER  |10.1.1.15 255.255.255.0 |10.1.1.255
ethl O0:0E:OC:35:YE:EE |10.1.3.1 255.255.255.0 |10.1.3.255
ethz 00:00:E0:55:4A:30 |10.1.4.1 255.255.255.0 |10.1.4.255
eth3 O0:00:60:55:4A:50 |10.1.5.1 235.255.2535.0 |10.1.5.255

Save | Cancel

7.2. Network Preferences
The Preferences dialog will also contain a Networks tab which will allow the user
to specify other static IP addresses for connection to other networks.

Refresh Interval TimE(SEES):IEO
Maxinum Messages:|250

Identify Cycle Time(secs):IEO
Icentify Cycle Count:IE

Default S5H Passwor‘d:lcluster“

Default BladeCenter User:|USERID
Default BladeCenter Password: PASSWORD

Sawe | Cancel |

7.3. Firmware
The final tab in the Preferences dialog will allow Firmware files (.sh flash
installers only) to be used by the appropriate nodes specified by their machine
type designation.

Firmware

HModel: |8840 Files: S
BIOS: |1.13 lgj ibm_fu_tins_kpel3sa_linux_intel32.sh
BMC: |1.0 ng ibm_fw_bnc_kpel38a linuk intel32.sh

Add Mew Firmware |

% To renoye an entry, clear the model field.

Save | Cancel |




7.4. Racking
Nodes can be grouped into other racks from the manager as well as the discovery
wizard. The Racking button under the Options menu will contain this dialog.

4|__;J| Grouping Configuration | fl )l
Modes Groups
LCIT {MT:0 SM:0) Y Rackl (MT:14104R¥ SN:S3R14L) —-|
0009EBECOLSC 10.1.5.172 23A0725 eserver xSeries 935
000DE0SS0ZFC 10.1.5.213 23A0212 eserver wSeries 336
001125410240 10.1.5.239 LOEETEA eserver xSeries 336 Set to Rack |
OO0DE0SS441A 10.1.5.214 KPAHOS1 eserver wSeries 345 | | o __
OOUEOCESTEGA 127.0.0.1 KPRHO49 eserver wSeries 246
Rackl (MT:14104R¥ SN:S3R14LY FEE) (e (e |
001 45E1D32D8 10.1.5.164 23A021L7 IEM eServer EladeCente
00112575046A 10.1.5.180 23A0540 IEM eServer EladeCente
00036BESS236 10.1.5.238 KPHFS72 IEM eServer EladeCente
000DE0SEIZDE 10.1.5.241 23A0024 IEM BladeCenter HS20
0003BEO0IEER 10.1.5.245 KPHLL7S IEM eServer ElaceCente
D00IBROOAEZS 10.1.5.246 KPH3B36 TEM eServer EladeCente
0009BRO04F 4TI 10.1.5.226 7611325 TEM eServer BladeCente| |
0009BRO0I7F4 10.1.5.243 KPH11E2 TEM eServer BladeCente
D0096R009774 10.1.5.228 KPH1157 TBM eServer BladeCente
0009EBO0I7AC 10.1.5.237 KPHLL72 IBM eServer BladeGerte| /

Ok Cancel

7.5. Discovery Wizard and Auto Discovery
The Discovery Wizard can be run at any time by the user after being inside the
manager. This will exit the manager program and re-enter the wizard. The Auto
Discover option allows the wizard to be run without any kind of user interaction
using all defaults to discover new nodes. Any new found nodes will appear as
“Unracked” in the manager and will need to be grouped via the Racking window
available from the Options menu.

NOTE: Nodes that were previously rack will keep their same racking
configurations.



8. Troubleshooting

This section will detail any known problems which may be encountered and possible
solutions to these problems.

8.1. Booting Problems

1.

The designated “Manager” node is not booting from the CD.

Make sure CD ROM is higher in the boot order than the Hard Disk, and
reboot the node. If failure persists, check the CD for scratches and verify
the burn was successful (if burned from an ISO).

During boot process, “Failures” appear.

Some Failure messages may appear but will not affect LCIT in any adverse
way. However, if the boot process hangs for more than 5 minutes without
any indication of process, it is possible that the CD may have errors. If
failure persists, check the CD for scratches and verify the burn was
successful (if burned from an ISO).

8.2. Discovery/First Run Problems

3.

5.

All nodes that have been turned on are not shown as having responded
after running the pinging process.
There are several possibilities, here are a few of them:

-The node may not be set to boot from the network (PXE). Change the
boot order for that node to make sure a network boot comes first.

-The node has not yet fully loaded the network image. Try pinging again
in a few minutes.

-If after several minutes all nodes are still not responding, check network
connections.

The Collection process is taking too long.

For large clusters, this can be expected to happen. Each compute node
takes about a second to process, storage nodes can take up to ten seconds
each, and BladeCenter controllers can take around a minute. As long as
the “dots” in the progress meter are constantly moving, the Collection
process should be moving along shortly. However, if this process is stuck
on a single IP for more than a few minutes, there could be further issues
(see below).

A single node has been on Collection for more than a few minutes.

This could indicate a bad network connection or some other kind of
network error. The best solution may be to clear the IP Range list of this
IP and be sure it is not included the next time. This can be done either by



removing all “list” files from the /opt/Icit directory, or by clearing out all
data that has been obtained by entering . / r eset _def aul t s from the
/opt/lcit directory. (Be warned, issuing this command will delete all logs,

lists, and node information files, resetting LCIT to a factory default state)

Some nodes do not show any collected information.

It is possible that the node has just recently booted into the network image
and has not yet had time to generate its information file. This tends to be
completed about one minute after a node has acquired an IP address.
Other possibilities include unsupported hardware or a failure to completely
load the network image after being assigned an IP address.

In the Grouping Configuration dialog, some nodes do not appear in the
list.

If a node which is shown in the tree does not show in the grouping list, it is
likely considered to be a Blade owned by a discovered BladeCenter. If this
is the case, those Blades will always be placed in the same rack group as
its BladeCenter. Blades which are in a discovered BladeCenter will appear
in the tree in a branch just under which one the Blade belongs to.

The Discovery Wizard was exited and the Manager failed to load properly.
Each time the Discovery Wizard is run, every step must be finished for the
Manager to properly run without errors. This is especially true the first
time LCIT is run without any configuration files, or after a reset to
defaults. If the Manager fails to load and there is no option to re-run the
discovery wizard, you may need to use the reset defaults command. This
can be done either by removing all “list” files from the /op#/Icit directory,
or by clearing out all data that has been obtained by entering

./ reset _defaul ts fromthe /opt/cit directory. (Be warned, issuing
this command will delete all logs, lists, and node information files,
resetting LCIT to a factory default state)



8.3. Cluster Manager Problems
9. The Manager hangs after first being loaded, or during operation.

First, try closing the manager. If this fails, click on the “Minus” symbol at
the very top left of the window and select “Kill” from this menu. Next,
use the LCIT button to bring up the Manager again. If the program hangs
at the loading screen for more than a minute, there may be some problems
in the configuration files and discovery may have to be run again. See the
last item in the previous section of troubleshooting for how to fix this.

10. A Node Identify command was issued and failed.
Either the node is currently not able to use the Identify feature (no BMC
attached, faulty BMC, or is a BladeCenter controller) or the node is no
longer responding on the network. To test if a node is responding, double
click on it from the node free and look to the status bar to see if the ping
was successful.

11. A Group (Identify, Eject CD, Update, Restart, or Shutdown) command was
issued and some nodes failed.
See the above answer. Additionally, Restart and Shutdown commands are
not available on the local management node (the node running LCIT).
Eject CD, Update, Restart, and Shutdown commands are not available for
Storage nodes and BladeCenter controllers.

12. A node which reported a successful Update did not appear to actually
update firmware.
If, after restarting from having reported a successful Update, the node did
not change firmware revisions as is reported in the node’s information file,
the update may have suffered from some other type of error. To see the
output from this, first open an SSH terminal to the node by first double
clicking on it, then scrolling to the bottom of its information page and
clicking “Open SSH”. From the new terminal window type: “updat e”
at the command prompt. Some errors, such as a “syntax error” only mean
that there was not a firmware update available for that system. Other
messages may help determine the cause for the inability to update the
firmware.



